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Windows Accessibility Tools 
 
Users may use these tools to change the display settings on a Windows PC to allow for easier 
viewing.  They may increase the size of fonts used, change the color combinations used on the 
screen and may change the contrast of the screen.  Users may also activate the Magnifier program 
to enlarge portions of the screen.  (In Windows click Start – Programs – Accessories – 
Accessibility – Magnifier.)   
 
Microsoft Windows has several built-in features that may benefit the user who has difficulty using a 
mouse and/or standard keyboard with default settings: 
 

Filter keys – May be used to slow the repeat rate of the keyboard or make Windows ignore 
repeated or brief key presses.  This should allow users with unsteady hands to type more accurately.                       
Default shortcut:  Hold the Shift key for more than 8 seconds.  This will bring up the Filter keys 
dialog box.  Clicking Settings will access the Accessibility Options. Here Filter keys and the rest 
of the keyboard related options can be configured.) 
 

Sticky keys – Allows user to use the Shift, Alt and Ctrl keys one at a time.  By default the 
user would press the desired key twice to lock the key.  Default shortcut:  press the Shift key 5 
times. 

 
Toggle keys – Allows the user to hear a tone when the Caps Lock, Num Lock, or the 

Scroll Lock keys are pressed.  Default shortcut: Hold the Num Lock key for 5 seconds. 
 
Mouse keys – Allows the user to control the mouse pointer using the numeric keypad on the 

keyboard.  Default shortcut: Left Alt + Left Shift + Num Lock keys. 
 
An On-screen Keyboard is also available. This feature allows a user to “type” by using the mouse 
pointer to click on the keys of a keyboard displayed on the screen. Activate by clicking Start -> 
Programs -> Accessories -> Accessibility ->  

On-screen Keyboard. 
 
Another feature of the Accessibility Tools is the Accessibility Wizard covered in the next section. 
________________________________________________________________________________ 

Making a personal settings floppy disk using the Accessibility Wizard 

The Accessibility Wizard guides you through the process of customizing your computer with tools 
designed to help meet your vision, hearing, or mobility needs. Accessibility options (such as 
StickyKeys, ShowSounds, and Mousekeys) help users with disabilities to make full use of the 
computer. Some of the options, such as MouseKeys, may be of interest to all users. Once the 
Accessibility tools are set up, they can be accessed through Control Panel and the Accessibility 
menu. 

Open the Accessibility Wizard  by clicking Start, point to Programs, point to Accessories, point to 
Accessibility, and then click Accessibility Wizard.  Create a default setup file by making a change 

 3



to a setting and then changing it back to what it was. Click “Next” until asked to save the personal 
setting file. Browse to an appropriate location to store the default settings file (usually a floppy disk 
or a flash drive) and save the file with the name “Default”. (This file can be used to change revert 
the computer back to its original settings as a courtesy to the next user.) 

Re-enter the Accesibility Wizard and make necessary adjustments to each setting before clicking 
“Next” to go to the next setting.  Once again, click “Next” until asked to save the personal setting 
file. Browse to an appropriate location to store the default settings file (usually a floppy disk or a 
flash drive) and save the file with the name “My Settings”. 

The disk may be used by inserting it in a computer, double-clicking the “My Computer” icon, and 
double-clicking the “3½ Floppy” icon.  Double-click the “My Settings” file to configure the 
computer to the new settings.    Double-click the “Default” file to set the computer back to the old 
settings. 

(Press F1 on the keyboard and search for Accessibility Wizard or see  
http://www.microsoft.com/enable/products/windowsxp/default.aspx  for more details.) 
________________________________________________________________________________ 

Configuring a left-handed mouse 

To reverse your mouse buttons: 

1. Open Mouse in Control Panel.  
2. Open the mouse settings by clicking Start, then point to Settings, click Control Panel, and 

then double-click Mouse.  
3. On the Buttons tab, under Button configuration, select the Switch primary and 

secondary buttons check box to make the right button the primary mouse button. Clear the 
check box if you want the left button to be the primary mouse button.  

Note:  If the mouse buttons were switched using the left mouse button, they will have to switched 
back using the right mouse button. 
________________________________________________________________________________ 
 
Using a Flash Drive 
 
    Flash drives (also known as thumb drives or pen drives) are data storage devices, like floppy 
disks, and come in different memory sizes ranging from 32 MB (Megabytes) up to 4 GB 
(Gigabytes).  A typical size is 128 MB.  A flash drive of this size has the storage capacity of about 
88 floppy disks.   
     The flash drive can be accessed by plugging it into the USB port on a PC (a green arrow on a 
small box should appear in the system tray on the bottom-right of the screen within 15 or 20 
seconds) then opening the File Explorer (right-click “Start” button then click “Explore”) or by 
double-clicking  the “My Computer” icon.  The flash drive should be listed as either “Removable 
drive” (for Windows 2000) or listed by its brand name (for example, “Lexar Media” for Jumpdrives 
on Windows XP).   
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(Note: do not confuse the flash “Removable drive” with the Zip disk “Removable drive” installed 
on some computers.)  Files can be saved to or opened from the drive the same way they can be on 
or from a floppy.  Some units even have a write-protect switch.   
       When finished using the drive, be sure to click on the green arrow in the System Tray (bottom-
right of the screen) then click “Safely remove USB mass storage device” (Windows XP) or “Stop 
USB device” (Windows 2000). WARNING: Failure to do this may result in loss of data.  The 
drive may be removed after the computer displays that it is safe to remove hardware.   
 
 
Key to Access 
 
Key to Access is a combination MP3 player and flash drive.  As a flash drive, it can store data files 
(such as Word documents, spread sheets, MP3 music files, etc.) and programs.  It comes with eight 
different assistive programs:  Scan and Read Pro, Universal Reader Plus, E-Text Reader, Ultimate 
Talking Dictionary, Talking Word Processor, PDF Magic, Text To Audio, Talking Calculator.  This 
device allows the user to use its software by clicking on an icon on a tool bar that pops up after 
plugging the device into the USB port on a PC.  This frees the user from having to use a specific 
computer with assistive software. 
 
Key to Access (MSRP $349.95) 
Premier Assistive Technology 
http://www.premier-programming.com/keytoAccess/Key.htm
________________________________________________________________________________ 
 
Using Kurzweil to convert text to a portable audio file (.mp3) 
 
Kurzweil (see “Text Readers” below) reads text that is scanned in and can also save the reading as 
an audio file.  A user can then play the audio file on any PC with Window Media Player or any 
other compatible player. 
Use the following steps to create the audio file: 

1. Scan the text into Kurzweil 
2. On the menu click “File”, “Audio Files”, then “Create Audio File…” 
3. On the settings box that pops up select (use the default settings if you are not sure): 

a. how much of the document you want converted to an audio file 
b. the type of voice and reading speed 
c. the Output File: 

i. Format 
ii. Quality 

iii. and File Name 
4. Click “OK” 

 
The file will be saved by default in:  
C:\Documents and Settings\All Users\Application Data\KESI\Output Audio\. 
The file can then be copied to a flash drive, burned to a CD, or uploaded to an MP3 player. 
________________________________________________________________________________ 
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Burning a CD Using Nero v 6.3.0.2 
 
Need to burn .mp3 files created with Kurzweil to a CD?  Here’s how: 
 
Start Nero. 
Click the CD tab for burning a CD. 
Click the Data icon (it looks like a sheet of paper). 
Click “Make Data Disk”. 
When the “Disk Content” window pops up: 
 Click the “Add” button. 
 Browse to and select the files to be burned and click the “Add” button. 
 When done adding files, click then “Finished” button. 
 Click the “Next” button. 
When the “Final Burn Settings” window appears: 
 Select the “Current recorder:” (This is usually the D: or E: drive.) 
 Optional:  Name the disc in the “Disc name:” text box. 
 Check the box beside “Verify data on disc after burning”. 
 Click “Burn”. 
The disc will be burned, then the disc tray will eject and retract for the verification process.    
A message box should appear stating the number of times buffer underrun was avoided.  Click the 
“OK” button. 
A message box should appear stating “Burn process completed successfully at 48x (7,200 KB/s).”  
(The numbers will be different with a faster of slower burn speed.)  Click the “OK” button. 
A window should appear asking: 
 “What do you want to do now? 
  Burn same project again 
  Cover Designer 
  Save project” 
Click the “Exit” button to return to the main screen. 
Click the power button (red button with a 1 inside a 0) to quit Nero. 
________________________________________________________________________________ 

 
Setting Up a Free Yahoo E-Mail Account 

 
1. Start Internet Explorer and go to www.yahoo.com. 
2. Click the Mail icon near the top of the page.     
3. Click the “Sign Up” link. 
4. Fill out all information fields with an  *  beside them. 
5. Read the code in the “Verify Your Registration” section and enter the code in the box 

beside “* Enter the code shown:” 
6. Read the “Terms of Service”. If acceptable, click the “I agree” button. 
7. Correct any errors in the form.  When corrected click “Submit”. 
8. Registration is complete.  Continue to the newly created account. 

 
________________________________________________________________________________ 
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Windows Keyboard shortcuts and mouse methods 
 
<F1>    Help 
<Shift + arrow key>    Select text 
<Control + a>   Select all text 
<Control + c>   Copy text 
<Control + v>   Paste text 
<Control + x>   Cut text 
<Tab key>    Move cursor to next field or box 
<Control + Right arrow>  Move a word at a time to the right 
<Control + Left arrow>  Move a word at a time to the left 
<Page Up>   Move up one page or screen 
<Page Down>   Move down one page or screen 
<Home>   Move to the beginning of the line 
<End>    Move to the end of the line 
<Print scrn>    Capture a picture of the whole screen to the clip board. 
<Alt + Print scrn>   Capture a picture of the currently active window  
<Alt-F4>   Close a window 
 
Menus may be opened by pressing <Alt> + the underlined letter in the menu name. 
  For example:  <Alt + f> opens the File menu. 
 
Use scroll bars more effectively by:  

grabbing the slider and moving it to the desired location 
   or 

clicking above or below the slider to scroll the screen one-page in time. 
These methods are much quicker than using the up or down arrows at the top and bottom of the 
scroll bar. 
________________________________________________________________________________ 
 
Data Loss Prevention 
 - Save a copy important work on a backup disk or disks. 
 - Self E-mail copies of work. 

- Print out important work. (Text can be scanned into a PC and converted back 
   into editable text using OCR software. 

 - Never eject a floppy disk or Zip disk while the drive light is on. 
 - Never remove a flash drive without first stopping the drive.  

  (See “Use a Flash Drive” above.) 
________________________________________________________________________________ 
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Free Anti-Spyware and Anti-Virus Software 
 
Computer viruses can damage or destroy files on a computer.  Ad-ware, software that installs pop-
up ads along with invisible snooping programs, usually doesn’t hurt data but can slow down a 
computer to the point of the computer becoming unusable. 
 

Free Virus Scanner  
AVG from http://www.grisoft.com

Free AdWare Scanners 
 SpyBot – Search and Destroy from  

http://www.safer-networking.org/en/index.html
 AdAware from http://www.lavasoftusa.com/software/adaware/

________________________________________________________________________________ 
 
Computer Related Terminology  
 
OCR – Optical Character Recognition software. Converts scanned text into e-text. 
e-text – Electronic text, such as a Word document. 
Install – to put software on a computer’s hard drive so that it may be run on the 
  computer. 
Copy – to duplicate a file, usually to a different storage medium (from a floppy to a  
 computer’s hard drive). 
Move – to transfer a file from on location to another. The file is deleted from the old  
 location. 
Download – to retrieve a file from a remote computer. (Downloading is NOT copying a  
 file from a floppy to a computer or installing a program.) 
Upload – to send a file to a remote computer. 
Burn a CD – to record data to a CD-R (a recordable CD) 
Boot – to start a computer from a powered off state. (Also known as a “cold boot”.) 
Reboot – to restart a computer without turning it off. (Also known as a “warm boot”.) 
Start/Launch/Run/Execute a program – to make a program go, usually by double- 
 clicking it’s icon. 
LCD – Liquid Crystal Display (NOT an LCD Display.) 
NIC – Network Interface Card (NOT a NIC Card) 
Ethernet cable – the cable that plugs into a computer’s NIC and runs the network socket 

on the wall.  (It looks like a thick phone cable.) 
________________________________________________________________________________ 
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Speech-to-Text Software 
 
Speech-to-Text Software allows users to speak into a microphone attached to a PC and have their 
speech converted into text.  This is useful for people with reading or learning disabilities or limited 
manual dexterity.  With this software the user can: 
  Create a document  

Edit text and 
Issue commands. 

The user must first go through a 20-minute training session in which the user reads selected text to 
the Speech-to-Text Software.  This training allows the software to adjust to the user’s speech 
patterns and accent.  Additional training may be required if the software’s accuracy needs to be 
improved. 
 
Several things affect the accuracy of the software: microphone quality, microphone positioning, 
speech pattern and ambient noise.  A high quality microphone ensures that an undistorted sound 
signal gets to the software.  (Noise-cancellation microphones are even better.)  The microphone 
should be positioned below or beside the mouth away from the main flow of air from the mouth to 
prevent the hiss of air against the microphone.  The user should speak in a normal, flowing voice.  
Speaking in a broken, start/stop pattern prevents the software from properly adapting to the user’s 
voice.  Finally, training should occur in the environment that the software will be used in.  This 
allows the software to adapt to and ignore the environment’s ambient noise. 
 
 
Speech Recognition Tool (included in later versions of Windows) 
Microsoft 
Install and configure:  
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q306537
 
 
Dragon Naturally Speaking Standard (MSRP $99.99) 
Dragon Naturally Speaking Preferred (MSRP $199.99) 
Nuance 
http://www.nuance.com/naturallyspeaking/
 
Dragon Naturally Speaking 8 Video Guide ($149.95) 
Solutions for Humans 
http://www.sforh.com/speech/dragon-guide.html
 
Via Voice Personal Edition (MSRP $29.99) 
Via Voice Standard Edition (MSRP $49.99) 
Via Voice Advanced Edition (MSRP $79.99) 
IBM 
http://www.nuance.com/viavoice/
Feature Matrix 
http://www.nuance.com/viavoice/matrix/
________________________________________________________________________________ 
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Text readers 

 
A text reader is a program that converts the text shown on a computer display into audible speech 
through a computer's speakers.  People that may benefit by using screen readers include people with 
learning disabilities, people with low or no vision, and people learning English as second language.  
Screen reading software allows a person to be independent of a human reader. 

Kurzweil 3000 

Kurzweil 3000 Professional Color (MSRP $1495) 
Kurzweil Educational Systems 
http://www.kurzweiledu.com/
 
Summary  
 
Kurzweil 3000 Professional Color allows the user to scan any text into the computer and then 
have the text read aloud by the computer using a synthesized voice.  The user may also use 
Kurzweil to read text or Word files and may even use it to read web pages. 
 
Using   
 
When Kurzweil is started, users have the option of selecting an existing account or creating a new 
account.  These accounts store the users’ custom settings.  (New users will probably want to create a 
new account.)  
 
Most users will only want to use the basic functionality of Kurzweil 3000.  This involves placing 
printed text (book, magazine, handout, etc.) in the scanner and pressing Kurzweil's Scan button 
(Picture of Scanner in the tool bar).  Text can be placed in the scanner upside down with no problem 
as Kurzweil will automatically turn the scanned text right-side-up. 
 
The user may scan in and read one-page a time, which may be inconvenient when reading multi-
page documents.  Clicking on the Scan menu and selecting Scan Repeatedly will cause a Message 
Box to pop up showing a 10 second countdown until the next scan and a button that labeled Done.  
This 10 second delay allows enough time for the user to position the text in the scanner.  The text 
will be scanned, then a Message Box with the 10 second countdown will pop up again.  When the 
last page is scanned the user may click the Done button in the Message Box to stop scanning. 

Once the page or pages are scanned in, the user may press Kurzweil's Read button (Green triangle 
in the tool bar) to have scanned text read aloud.  The user may adjust the read speed with the up and 
down arrows (to the left of the box labeled “WPM”) to select the read rate in words per minute.  
The user may also adjust the size of the displayed page with the text size adjust arrows next to the 
box labeled “Zoom”. 
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Some users may not like the default voice used by Kurzweil; it sounds very mechanical and 
robotic.  Users may change the voice used by Kurzweil by a clicking on the TOOLS menu then 
clicking Options.  Click the Reading tab and in the Speaker section select the desired voice from 
the Speaker pull-down menu.  Press the Test Speech button to hear the selected voice. 

Normally Kurzweil will read columns of text in the same way that newspapers and magazine 
articles are read.  Occasionally it will be necessary to override reading columns, such as when 
trying to read a list of words on the left side with the definitions of the words on the right side of the 
page.  The user can change the way in which Kurzweil reads the text by changing the reading zones 
with Tools menu -- > Edit Zones.  The user may then delete the old zones and add the desired new 
zone or zones by dragging a box around the desired text.  When done editing the new zones the user 
will exit zone editing with Tools menu -- > Edit Zones. 

Dictionary, Syllables and Spelling 

Use the Dictionary, Syllable, and Spelling features by double-clicking on the desired word (the 
word will be highlighted), and then clicking on the appropriate button.  A window will pop up 
showing the word and its definition, syllables or spelling.  Pressing the Read button will cause the 
word and definition, syllables or spelling to be read.     

Testing 

Students will occasionally need to use Kurzweil to take a test.  If the test involves definitions, it 
may be necessary to turn off Kurzweil's dictionary.  To do this, click on the Tools menu, select 
Options, and click on the Lock Features tab.  Under the section labeled Reference Tools, make 
sure that the option called Dictionary Enabled is unchecked.  If the test involves synonyms make 
sure the Synonyms Enabled checkbox is unchecked.  Check of the Password-protected Features 
checkbox and enter a password.  This feature requires that anyone attempting to change any locked 
features to enter the appropriate password. 

Highlighting 

Just as highlighters may be used to mark important passages in a regular book, the same function 
may be performed in Kurzweil with the Highlighter tools.  The Highlighter tools, when active, 
shows up in the tool bar as green and yellow high lighters.  If the Highlighter tools are not visible, 
activate the highlighters by right-clicking on an empty space on the toolbar, going down to Apply 
Toolbar Set and selecting Content Reading.  (This should be option 2.)  The highlighted text may 
be saved to a file by clicking File, then Extract, Highlights. A window with only the highlighted 
text will pop up.  Click File – Save As then pick a folder then a file name to save the extracted text. 
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Problems 
 
Text with Colored Background 

The contrast level between text and colored background sometimes is too low for Kurzweil to 
accurately recognize the text.  To compensate for this, turn on the dynamic threshold option.  To do 
this click the Tools menu, go to Options, and select the Scanning tab.  The section in the lower half 
the window, called Extras, contains an option called Dynamic Threshold.  Make sure this option 
is checked. 

Highlighted Text 

Text that has been highlighted may not be visible to the scanner.  The highlighted areas may show 
up as black with the text being obscured by the highlighting.  Highlighter colors known to cause this 
problem are pink, and sometimes green and blue.  Most text highlighted in yellow is readable by the 
scanner. 

Improper Document Placement on Scanner 

If the book is placed in the scanner and the page to be scanned is not completely flat on the scan 
bed, the text near the spine of the book may not get scanned properly.  Apply gentle pressure to the 
spine of the book to make sure the entire page is flat on the scan bed.  ** Warning!  Too much 
pressure may damage the scanner. ** 

If the page adjacent to the one being scanned from a book is on the scan bed, some of the text on 
that page may be scanned.  To eliminate this unwanted text, position the book so that the adjacent 
page is not on the scan bed or temporarily tape a blank sheet of paper to the scan bed so that only 
the desired page is seen by the scanner. 

Kurzweil 3000 LearnStation (MSRP $395) 
Kurzweil Educational Systems 
http://www.kurzweiledu.com/
 

Kurzweil 3000 LearnStation has the same reading capability of the Professional Color version 
but can not perform the scan function; it only reads text already in electronic format, such as .doc, 
.rtf and .txt files. Users may use a scanner to scan text into the computer and then use optical 
character recognition (OCR) software, such as OmiPage Pro or Abby Fine Reader to convert the 
scanned text into editable and readable text.  (Most scanners come with some form of OCR 
software.)  The user should save the converted text file and then open the file in Kurzweil for 
reading. (File menu, Open, then browse to the desired file.) 

Kurzweil 3000 LearnStation is available in a network edition. 
________________________________________________________________________________ 
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Scan and Read Pro (MSRP $149.95) 

By Premier Assistive Technology 
http://www.premier-programming.com/snrp/SNR_PRO.htm
(Tutorial videos are available at the above link.  Look on the right-hand side of the page.) 
 
The basic operation Scan and Read Pro is the same as that of Kurzweil 3000 Read Station; the 
user places the desired text in the scanner, presses the Scan button (picture of a scanner) in the 
toolbar and after the text is scanned presses the Read button (mouth) to have the scanned text read 
aloud. Scan and Read Pro does not have some of Kurzweil 3000 Scan Station’s advanced 
features such as highlighting. 
 
When using Scan and Read Pro for the first time it may be necessary to select the scanner used by 
the computer.  Do this by clicking the Scan menu, clicking the Select Scanner option and selecting 
the attach scanner from the displayed list. 
 
Users may change the default voice used by Scan and Read Pro right clicking on the Voice button 
(picture of microphone) and selecting the desired voice.  The user may also adjust the reading speed 
by sliding the Voice Rate slider to the right to increase the reading speed and to the left to decrease 
the speed.  The pitch of the voice may be adjusted by using the Voice Pitch slider. 
 
 
(Scan and Read Pro is included on the Key to Access device.  See above.) 
________________________________________________________________________________ 

ReadPlease (Free version available for download) 

By ReadPlease 
http://www.readplease.com/
 
ReadPlease, much like Kurzweil 3000 LearnStation, does not scan text into the computer.  
ReadPleaseonly reads text already in electronic form. It is up to the user to scan and convert any 
hard copy text. 
 
In order to read e-text, the user can open the e-text with ReadPlease.  Clicking the Play button 
(green triangle on the left-hand side of the window) will cause ReadPlease to read the e-ext.  E-text 
may then be selected by highlighting, copied, and then pasted into the text region of ReadPlease for 
reading.  ReadPlease has variable reading speed controls and an option for low vision color. 
 
ReadPlease Plus 2003  (MSRP $59.00) 
By ReadPlease 
http://www.readplease.com/
 
ReadPlease Plus 2003 has all the features of ReadPlease® plus several additional features such as 
text highlighting while reading and the ability to add custom word s and pronunciations. 
________________________________________________________________________________ 
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Microsoft Narrator (Included with Windows 2000 and XP) 

Microsoft  http://www.microsoft.com/enable/training/windowsxp/usingnarrator.aspx
 
Microsoft Narrator is a basic screen reader mainly designed to work with the Windows operating 
system and some of its programs, such as Notepad, WordPad, Internet Explorer and the 
Windows Desktop.  It may not work accurately with third-party (non-Microsoft) programs 
therefore the user may want to obtain specialized screen reading software. 
 
Narrator may be started by pressing the Windows logo key + U.  (On keyboards without a 
Windows logo key, use Ctrl + Esc + U.)  It may also be started by clicking Start, pointing to 
Programs, Accessories, Accessibility, and then selecting Narrator. 
 
The Narrator voice may be adjusted by clicking on the Voice button in the Narrator dialog box, 
or by pressing the V key on the keyboard, and then clicking on the left or right arrows to increase or 
decrease the Speed, Volume and Pitch to the desired setting.  The user may select Speed from the 
keyboard by pressing Alt + T, the Volume by clicking Alt + O, or the Pitch by clicking Alt + P.  
Once selected the setting may be adjusted with the up and down arrows on the keyboard. 
 
Narrator may be turned off by clicking the Exit button in the Narrator dialog box and then 
clicking Yes. 
________________________________________________________________________________ 
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	Once the page or pages are scanned in, the user may press Kurzweil's Read button (Green triangle in the tool bar) to have scanned text read aloud.  The user may adjust the read speed with the up and down arrows (to the left of the box labeled “WPM”) to select the read rate in words per minute.  The user may also adjust the size of the displayed page with the text size adjust arrows next to the box labeled “Zoom”. 
	Normally Kurzweil will read columns of text in the same way that newspapers and magazine articles are read.  Occasionally it will be necessary to override reading columns, such as when trying to read a list of words on the left side with the definitions of the words on the right side of the page.  The user can change the way in which Kurzweil reads the text by changing the reading zones with Tools menu -- > Edit Zones.  The user may then delete the old zones and add the desired new zone or zones by dragging a box around the desired text.  When done editing the new zones the user will exit zone editing with Tools menu -- > Edit Zones. 
	Dictionary, Syllables and Spelling 
	Use the Dictionary, Syllable, and Spelling features by double-clicking on the desired word (the word will be highlighted), and then clicking on the appropriate button.  A window will pop up showing the word and its definition, syllables or spelling.  Pressing the Read button will cause the word and definition, syllables or spelling to be read.     


	Testing 
	Students will occasionally need to use Kurzweil to take a test.  If the test involves definitions, it may be necessary to turn off Kurzweil's dictionary.  To do this, click on the Tools menu, select Options, and click on the Lock Features tab.  Under the section labeled Reference Tools, make sure that the option called Dictionary Enabled is unchecked.  If the test involves synonyms make sure the Synonyms Enabled checkbox is unchecked.  Check of the Password-protected Features checkbox and enter a password.  This feature requires that anyone attempting to change any locked features to enter the appropriate password. 

	Highlighting 
	Just as highlighters may be used to mark important passages in a regular book, the same function may be performed in Kurzweil with the Highlighter tools.  The Highlighter tools, when active, shows up in the tool bar as green and yellow high lighters.  If the Highlighter tools are not visible, activate the highlighters by right-clicking on an empty space on the toolbar, going down to Apply Toolbar Set and selecting Content Reading.  (This should be option 2.)  The highlighted text may be saved to a file by clicking File, then Extract, Highlights. A window with only the highlighted text will pop up.  Click File – Save As then pick a folder then a file name to save the extracted text. 

	 Problems 
	 
	Text with Colored Background 
	The contrast level between text and colored background sometimes is too low for Kurzweil to accurately recognize the text.  To compensate for this, turn on the dynamic threshold option.  To do this click the Tools menu, go to Options, and select the Scanning tab.  The section in the lower half the window, called Extras, contains an option called Dynamic Threshold.  Make sure this option is checked. 

	Highlighted Text 
	Text that has been highlighted may not be visible to the scanner.  The highlighted areas may show up as black with the text being obscured by the highlighting.  Highlighter colors known to cause this problem are pink, and sometimes green and blue.  Most text highlighted in yellow is readable by the scanner. 

	Improper Document Placement on Scanner 
	If the book is placed in the scanner and the page to be scanned is not completely flat on the scan bed, the text near the spine of the book may not get scanned properly.  Apply gentle pressure to the spine of the book to make sure the entire page is flat on the scan bed.  ** Warning!  Too much pressure may damage the scanner. ** 
	If the page adjacent to the one being scanned from a book is on the scan bed, some of the text on that page may be scanned.  To eliminate this unwanted text, position the book so that the adjacent page is not on the scan bed or temporarily tape a blank sheet of paper to the scan bed so that only the desired page is seen by the scanner. 



	Kurzweil 3000 LearnStation (MSRP $395) 
	Kurzweil 3000 LearnStation has the same reading capability of the Professional Color version but can not perform the scan function; it only reads text already in electronic format, such as .doc, .rtf and .txt files. Users may use a scanner to scan text into the computer and then use optical character recognition (OCR) software, such as OmiPage Pro or Abby Fine Reader to convert the scanned text into editable and readable text.  (Most scanners come with some form of OCR software.)  The user should save the converted text file and then open the file in Kurzweil for reading. (File menu, Open, then browse to the desired file.) 
	Kurzweil 3000 LearnStation is available in a network edition. 

	 
	Scan and Read Pro (MSRP $149.95) 
	ReadPlease (Free version available for download) 
	Microsoft Narrator (Included with Windows 2000 and XP) 


